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Mosart Web Applications are value-adding utilities and plugins that simplify working with Viz
Mosart.
Mosart Web Applications are not part of a standard Viz Mosart delivery.

The following Mosart Web Applications are available:
Mosart NRCS Plugin
Mosart Timing Display

Mosart Rundown Viewer
Mosart Dashboard
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1 Download

Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

A Note: If upgrading, make sure an existing instance of the Mosart Web Applications
Configuration Tool is not open.

Copyright © 2024 Vizrt Page 6
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2 Installation

The Mosart Web Applications bundle shall be installed on the Viz Mosart server.
1.

Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

Version 1.4.0.0

Viz Mosart Web Applications is a growing collection of modern,
browser-based utilities, designed to enrich the Mosart worlflow.

The following applications are about to be installed:

* iz Mosart NRCS Plugin
* iz Mosart Timing Display

INSTALL

The web applications that will be installed are listed.

A Note: The Installer places two applications on the local machine
a. Vizrt Mosart Web Applications
b. Vizrt Mosart Web Applications Configuration Tool

2. Click Install.
Any previously installed versions of the Mosart Web Applications are automatically
upgraded.

3. After successful installation, a Mosart Web Applications Configuration Tool automatically
displays.

2% Mosart Web Applications L Settings

] ® CONFIGURATION REQUIRED ® ONLINE &8 © ONLINE

&/ NRCS Plugin B Timing Display = Rundown Viewer

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information for The Rundown viewer provides a read-only
effortlessly insert Viz Mosart template information the studio control room and studio floor. presentation of the Rundown.
into an NRCS.

® Documentation % Configure ® Documentation (@ Documentation
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A Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by
default.

L ©
e

Vizrt Mosart

1IIIII|II-E I:I
Applications
Configuration

Tool

4. Port settings (optional)

Where security policies restrict ports firewall ports, these are the necessary port numbers for
Mosart Web Applications:

a. Web Apps REST API
HTTP: 55142 .

HTTPS: 55143.

b. Remote Control Service (Used by the Timing Display and Rundown Viewer)
HTTP: 55167 .

HTTPS: 55168.

For further setup, follow the Configuration sections of the Setup and Administration for the
different Web Applications, NRCS Plugin, Timing Display and Rundown Viewer.

Copyright © 2024 Vizrt Page 8
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3 Related Documents

Viz Mosart User Guide: Contains information on how to use Viz Mosart in live production.
For more information about all of the Vizrt products, visit:

www.vizrt.com

Vizrt Documentation Center
Vizrt Training Center

Vizrt Forum

Copyright © 2024 Vizrt Page 9
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4 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

Copyright © 2024 Vizrt Page 10
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5 Mosart NRCS Plugin

The NRCS Plugin is an effective drag and drop tool for reliably adding Viz Mosart template
instructions to an NRCS story.

Working with the NRCS Plugin

Setup and Administration

Integrating with an NRCS

Hosting NRCS Plugin within Pilot Edge

A Note: For news-breaking details on the Mosart NRCS Plugin, please refer to the Mosart Web
Apps Release Notes for your version of Viz Mosart at the Vizrt Documentation Center.

@ Tip: This document contains animated graphics. If you are viewing as PDF, we recommend
browsing the web version.

@ |

Templa

DEMO
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=
. CAMERA

B voiceovercuips

ﬁ Copy MOS ﬂ Insert item
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os Transition:
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B crerHicS l cLp
B rloar l Default
A ACCESSORIES
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C COMMAND
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5.1 Working With The NRCS Plugin

The NRCS Plugin delivers the functionality previously provided by the legacy Viz Mosart
ActiveX Plugin.

User Operations
- Getting Help
Error Handling
- API Documentation

5.1.1 User Operations

- Searching for a Template
Modifying a Template
- Adding Template Details to the NRCS
- Template Change Alert
- Optimizing Your NRCS Plugin Workspace
- Copying the MOS Object Details
Modifying Existing MOS Objects

Searching for a Template

Locate a template by typing a variant or template type in the Search box. Auto-suggest starts
displaying search results as you type.

Copyright © 2024 Vizrt Page 12



2 |\

Template set

DEMO

CAMERA
VOICE OVER CLIPS

FULL SOUND CLIPS

VIDEO EFFECT
SOUND
GRAPHICS

B roar

A ACCESSORIES

[ sreax

C COMMAND

Text highlighting helps with pinpointing search results:

Template set

Talkshow

«

l ﬁuu_

C GRAHICS [ROJjILE

. PACKAGE

Modifying a Template

To modify production characteristics

Variables
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E Copy MOS ﬂ Insert iterm

CAM 1

Transition:
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Click on a template in the search listing. Properties (called Variables) that have been added
to the template (using Viz Mosart's Template Editor) appear to the right.

& Note: Variables are called Newsroom tags in the Viz Mosart Template Editor.

You can temporarily override any defaults, and add new variables.
For example, in a Video Effects template, you may wish to change the source of the second
input:

E Copy MOS

TEST 2BOX

Variables:
inpl

CAM2
cAM3
CAM4

LIVE1

Transitions

The Transition field initially displays the default transition type. This value indicates the
most significant template behavior.

You can temporarily modify this transition type, and then later restore the default transition
(as originally set in the Template Editor).

& You can restore the default transition by clicking the Reset button.

ALL
CAMERA
VOICE OVER CLIPS

CAM 2
FULL SOUND CLIPS

0s Transition:

VIDEO EFFECT MIX WIPE EFFECI'

2 y frames
SOUND
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Adding Template Details to the NRCS

Drag and drop the template into the required location of the story slug.

A Note: The names of both the gallery and the template set of your selected template
are always included with the MOS object that you store as a story item in your NRCS
rundown.

Any future use of this NRCS MOS item will always point to exactly the same
template (same gallery, template set and template name) when it displays in the
Mosart NRCS Plugin.

Template Change Alert

If simultaneous changes are being made to the active template set (by another operator
using Viz Mosart's Template Editor), the Refresh button flashes orange.
To fetch the latest changes, click the Refresh button.

() Mosart NRCS Plugin

Gallery Template set

= DEMO

Optimizing Your NRCS Plugin Workspace
Collapsing the Type listing

You can save some screen space taken by the Mosart NRCS Plugin by collapsing the Template
Types panel:

Copyright © 2024 Vizrt Page 15
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Click the Collapse button.
@ Mosart NRCS Plugin

@ Mosart NRCS Plugin

Template set Template set

DEMO

B oA

B cavera

[ voicEOVER CLIPS
[ ruLLsounp cups

os

Scaling the View
As the Plugin is a web application, you can set your preferred scale by zooming in and out.

Fo

r most browsers, you can use the shortcut Ctrl+mouse wheel.

CcAM 3

Tem
L :
‘ E] g H
G : a - B copyos o insrttem
et .
et 5
;

Transition:

wix | wine et | <5

Copying the MOS Object Details
You can work with the template's raw MOS data by first copying it to your PC's clipboard.

From a selected template, click Copy MOS.

CAM 2

Transition:
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Modifying Existing MOS Objects

Your rundown will usually contain slugs with MOS objects that have been created with either this
Mosart NRCS Plugin or the legacy component, Viz Mosart ActiveX.

To modify an existing MOS object

1. On the selected rundown story, double-click the slug or grommet that holds the story's MOS
object.

2. The corresponding Viz Mosart template, complete with any control details like
newsroomtags, crosspoints, transition, timings, is displayed in the Viz Mosart NRCS Plugin.

VizMosartNCSPlugin = |

& Mosart NRCS Plugin

Transitio

Reset to default: MIX 0
MIX WIPE EFFECT

0 4 frames

JINGLE
I TeerHONE
BB Floar
B sreax

Editing: CAMERA 1
0K Cancel Applv
You make modifications direct in the Mosart NRCS Plugin window.
3. The name of the template you are working and reference to which template set it is part of,

is displayed on the border of the Plugin menu.
[ Mosart NRCS Plugin

Template set
DEMO

Editing: CAMERA 2

B voiceEover cLps

B ruLsounp cups

When finished editing click Apply, then OK.
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& Note: You cannot modify a MOS object that refers to a not-found Viz Mosart
template.

@ Mosart NRCS Plugin

Your production cue item CAMERA 2A refers to an unknown template from
Template set a template set named Funcspec (in gallery Testlab). Please contact your
System Administrator, as there may be an issue with the connection to your

Viz Mosart template database.

= ALL

To modify MOS objects created with the Mosart NRCS Plugin

MOS objects created by the Mosart NRCS Plugin include references to the gallery name and
template set name.

A Note: The active Gallery and/or Template set name may automatically change if your
selected MOS object references a different gallery/template set. You are always
notified if this happens.

VizMosartNCSPlugin

@ Mosart NRCS Plugin

Template set

10
10 - Copy
100

101

If your rundown item refer to a template set that cannot be found in the gallery, the Mosart
NRCS Plugin checks the active gallery and template set for a corresponding template. This
valid reference is then applied to the MOS object, when you click Apply on the replacement
template.

VizMosartNCSPlugin | x|

rt NRCS Plugin

{from gallery Testlab).

—

10- Copy

«

B cAvera

B rackace

100 Transition

JINGLE

c
|
|
|
|
I
=
| =
|
|
|
|

B eerHoNE
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Alternatively, you can manually search gallery/template sets to locate a similar template.
After editing and clicking Apply, the new (active) gallery and template set name are stored in
your rundown MOS object.

[& Mosart NRCS Plugin

WIPE

JINGLE

2 c
o |
I.w
-
[ L
I-
I
l.w
|
|
|
I -

[l EerHONE

To edit MOS objects created by ActiveX

When working with MOS objects that were created with Viz Mosart's legacy NRCS Plugin (Mosart
Active-X) the currently selected gallery name and template set name will always be used as
template source.

In the Plugin, ensure to select correct gallery and template set before you start editing.

5.1.2 Getting Help

The NRCS Plugin documentation is continually updated and available online. This includes both
this User Guide and the Release Notes.
You can also send your feedback directly to the Mosart NRCS Plugin design team.

Click the Question mark icon at the top right:

@ | &

Documentation

What's new

Give feedback

About

5.1.3 Error Handling

While navigating through templates, if there are exceptional conditions, the Mosart NRCS Plugin
displays an error message.
See the example below:

Copyright © 2024 Vizrt Page 19
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Ra Mosart NCS Plugin

Failed to fetch galleries
Host address: localhosta

No response from server. Network Error

Please contact Vizrt Support if you encounter any error messages.

5.1.4 API Documentation

The NRCS Plugin also installs the Mosart REST API. Details about the APl endpoints are provided in
the open APl documentation (Swagger Open APl (OAS) documentation) at:
http://localhost:55142/docs

A Note: Replace localhost with the IP address of the computer on which the APl is installed.

Examples

Retrieve all galleries:

http://localhost:55142/api/v1/galleries

(A list of gallery names is obtained)

Choose a gallery name from the list obtained in the previous example. For the sake of this
example, assume that Local was on the list. (If not, choose some other gallery name.)

To retrieve the template sets for the gallery named Local-
http://localhost:55142/api/v1/galleries/Local/templatesets.

Copyright © 2024 Vizrt Page 20
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5.2 Setup And Administration

This section describes setup and post-installation configurations, usually performed by a system
administrator.

- Setting up the NRCS Plugin
- Download
Installation
Configuration
- Additional Server Settings
- Verifying the Installation
- Troubleshooting
- Web Apps Service Reports as Offline
Bypass the Mosart Web Applications Configuration Tool to Access Web Apps

Firewall Ports

Before the NRCS operators can work with Viz Mosart templates using the Plugin, the system
administrator must complete a one-time setup.

5.2.1 Setting up the NRCS Plugin

Perform all three procedures, Download, Installation and Configuration.

Download

- Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

& Note: If upgrading, make sure an existing instance of the Mosart Web Applications
Configuration Tool is not open.

Installation

The Mosart Web Applications bundle shall be installed on the Viz Mosart server.

Copyright © 2024 Vizrt Page 21
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1. Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

Q

Viz Mosart Web Applications is a growing collection of modern,
browser-based utilities, designed to enrich the Mosart workflow.

Version 1.4.0.0

The following applications are about to be installed:

* Viz Mosart NRCS Plugin
* iz Mosart Timing Display

INSTALL

The web applications that will be installed are listed.

& Note: The Installer places two applications on the local machine
a. Vizrt Mosart Web Applications
b. Vizrt Mosart Web Applications Configuration Tool

2. Click Install.
Any previously installed versions of the Mosart Web Applications are automatically
upgraded.

3. After successful installation, a Mosart Web Applications Configuration Tool automatically
displays.

&% Mosart Web Applications BF Settings

-~ ® CONFIGURATION REQUIRED ® ONLINE =3 ® ONLINE
@

NRCS Plugin B Timing Display = Rundown Viewer

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information for The Rundown viewer provides a read-only
effortlessly insert Viz Mosart template information the studio control room and studio floor. presentation of the Rundown.
into an NRCS.

® Documentation ¥ Configure ® Documentation (@ Documentation

Copyright © 2024 Vizrt Page 22
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A Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by
default.

L ©
e

VizrtMosart

Web
Applications
Configuration

Tool

4. Port settings (optional)

Where security policies restrict ports firewall ports, these are the necessary port numbers for
Mosart Web Applications:

a. Web Apps REST API
HTTP: 55142.

HTTPS: 55143.

b. Remote Control Service (Used by the Timing Display and Rundown Viewer)
HTTP: 55167 .

HTTPS: 55168.

Configuration

e ]

&» Mosart Web Applications

13) @® CONFIGURATION REQUIRED m @ ONLINE

(& NRCs Plugin Timing Display

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information f{
effortlessly insert Viz Mosart template information the studio control room and studio floor.
into an NRCS.

(® Documentation 3% Configure (® Documentation |24}

1. If the warning CONFIGURATION REQUIRED appears in the NRCS Plugin panel, click Configure.
Follow the guidelines below:

Copyright © 2024 Vizrt Page 23
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Step Description

(1) Template location Select whether your Viz Mosart templates are defined

in a local file or on a separate database.
NRCS Plugin Configuration

Where are the Mosart Templates stored?

® Local file

Database

(2) Template access Local: Usually C:\channeltemplates\

A check is made for existence at the stated
destination, for all three files:

channeltemplates.xml

avconfig.xml

newsroomsettings.xml

If all are found, a confirmation text Valid
folder is displayed.

Click Next.
Please choose the location of channeltemplates.xmi

channeltemplates | [—§

Database: URL (Host + DB name) and DB access
credentials

Copyright © 2024 Vizrt Page 24
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Step Description

(3) NRCS type Select the NRCS system you are using.
Supported systems are ENPS , iNEWS , Octopus .

Any NRCS that can handle html plugins should work
(select Other), but the above 3 are supported.

NRCS Plugin Configuration

Please choose which NRCS you are using

ENPS ~

Please specify mos id

mos id
Mandatory field if you select NRCS type ENPS,
Octopus or Other.
(not used in iNews).

To find yourMos ID

a. In the Manus Administrator console, type
SETTINGS.

b. From the configuration panel that opens,
look for Mosld.

c. The value is defined in the column to the
right (in this example mosart.mos)

H settings

]

~ NCS configuration
Forced Mos protocal version
Ignore Send Cue Status To NCS Fer Offine Clips Faise
Lower port 10540
Mos server fimeaut 0.0.00
I mosart mos
NCS Time Zene
NCS Type Generic
NSl NCSSERVER
NCSId Backup

Mosld
MOs of this instance of the Generic value is mosart <gallerylD>.<station| D>.mes

For more details, see the Viz Mosart Administrator
Guide , section Manus Administrator > Settings Editor
MOS > NRCS Configuration.

Copyright © 2024 Vizrt Page 25
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2. Setup is complete and a confirmation menu summarizes your details.
NRCS Plugin Configuration

@ NRCS plugin is available

http 55142/plugin?n News IE1 copy

Follow the documentation for setting up the NRCS plugin:

NRCS Plugin Documentation

3. Click Finish.

Additional Server Settings

Web Server Hostname

At startup, the Configuration Tool attempts to autodetect the web server hostname and if
successful, pre-populates the field.

For some setups, the Configuration Tool's web server pre-populated hostname will differ from the
fully qualified domain name (FQDN). For example, the hostname gets automatically pre-populated
as web-apps, yet the FQDN is web-apps.example.com.

To Enable Network Communication with Mosart Web Apps
You can enable other machines on the network to reach Mosart Web Apps.

1. From the Configuration Tool menu bar, click the Settings (gear) icon. The Server
Configuration menu appears.

'3:[- Settings

Web server hostname VIZRTVI-CV79R6R

Use HTTPS

Certificate File
Private Key

Password

@ Documentation

2. In Web server hosthame, enter the FQDN.
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3. Click Save.

Enabling HTTPS

The Web Applications suite optionally supports HTTPS authentication for the applications running
under it, with a centralized interface to help with certificate configuration.

& Note: Depending on the application, some additional configuration may be needed in the
connected applications (for example Viz Mosart itself) to enable HTTPS communication.

Step 1 - Activate HTTPS in Mosart Web Applications

1. Launch the Viz Mosart Web Applications Configuration Tool (a desktop shortcut is usually
available by default).

2. In the top right corner, select the Settings (gear) icon. The Server Configuration menu
appears.

3. Select Use HTTPS.

& Note: This selection turns on HTTPS for the NRCS Plugin, Mosart Timing Display and
Rundown Viewer.

4. Provide certificate, key and authentication details (consult with your IT department to obtain
this).

-
Server Configuration X

]

1

()

1

]

]

» ONLINE
B Rundoy
]
]
]
!
F
]
]
]
I
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]

Web server hostname win-8urgf15ss8p

¥ Use HTTPS

Certificate File C:\Sources\sshl-win-Burqf15ss8p.c ‘ (]
Private Key C:\Sources\sshl-win-8urqf15ss8p.} ‘

Password

-C'_?_] Documentation

5. Click Save.

Step 2 - Turn HTTPS on in Mosart Remote Dispatcher Service

1. Copy the file C:\Program Files (x86)\Mosart Medialab\Mosart
Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml" to "C:\ProgramData\Mosart
Medialab\ConfigurationfFiles.

2. Fill in the following fields, using the same three values from the HTTPS Configuration menu
shown above:

SignalRUseHttps: true
SignalRCertificatePath: <Certificate File entered above>

SignalRCertificateKeyPath: <Private Key entered above >
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- SignalRCertificatePassword: <Password entered above >

name=
name

name

name

3. Restart the Remote Control Service.

Verifying the Installation

1. After entering NRCS type above, clicking Next starts a background Windows service, Mosart
REST API (a combination of the REST API and the NRCS Plugin).
2. You can check that the NRCS Plugin is accessible by either:
a. In the Configuration Tool, clicking Open.

€ Viz Mosart Web Applications

-~ W OBLINE
&) NRCS Plugin

This

MRCS lirk:

{¥) Documentation i Reconfigure

or

b. following button.

the URL next to the Cop

MRCS link:

& The Plugin URL comprises the machine name, port number 55742, NRCS type
and (when supported) mos id in the form: http://machine-name:55142/

plugin?nrcs={type}&mosid={mosid}

3. To complete the integration, configure the NRCS side, according to the appropriate NRCS as
described in section Integrating with an NRCS, where you will use the copied URL.

5.2.2 Troubleshooting

Web Apps Service Reports as Offline
At any time you can start the Mosart Web Applications Configuration Tool and check operating
status.
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A common error is when a Windows service has failed.

- Try restarting the service with the Restart button.
@ Viz Mosart Web Applications

Windows Service is offline. Try to restart it.

(»2) OFFLINE OFFLINE
-’

NRCS Plugin (9 Timing Display

This NRCS plugin enables a Viz Mosart operator to The Timing Display provides timing information for

- You can also rewrite any previously entered values with the Reconfigure button.

Bypass the Mosart Web Applications Configuration Tool to Access Web Apps

In failure situations, you can use your web browser to communicate with the Mosart Web Apps
(instead of the Configuration Tool).

NRCS Plugin

1. From the Configuration Tool, copy the NRCS link (click Copy).

/3' ® ONLINE
(%) NRCS Plugin

This NRCS plugin enables an NRCS operator to

effortlessly insert Viz Mosart template information
into an NRCS.

NRCS link:

The URL has the form similar to: http://<your-hostname>:55142/plugin/?
nrcs=ENPS&mosid=mosart
2. Open you web browser and paste the URL in to see the NRCS Plugin.

Rundown Viewer

Edit the URL to: http.//<your-hostname>:55142/rundown

Timing Display
Edit the URL to: http.//<your-hostname>:55142/timingdisplay/editor

Firewall Ports

Refer to the optional Configuration step Port settings (optional).
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5.3 Integrating With An NRCS

This section describes

NRCS Integration
ENPS
iNEWS
Octopus

- The server-based plugin configuration described below avoids having to configure each

individual NRCS client.
- This section assumes the Mosart NRCS Plugin has been successfully installed and set up, as
described in section Setup and Administration.

5.3.1 NRCS Integration

The NRCS Plugin supports connections to

ENPS
iNEWS
Octopus.

& Note: Initial investigations show that the NRCS Plugin also works with OpenMedia. However
this connection is currently not officially supported by Vizrt.

You connect each client NRCS machine to the Viz Mosart server (which hosts the Mosart REST API.)

ENPS

1. In the Configuration Tool (if not already running, select Windows Start > Viz Mosart NRCS
Plugin Configuration Tool) on the Mosart server, collect the NRCS Plugin's URL with the Copy
button:

@ NRCS plugin is available

plugin?nrcs=ENP

2. On the ENPS machine, navigate to System Maintenance > MOS Configuration.
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3. Paste the NRCS Plugin's copied URL, similar to the example below:

A

Description * 1 ActiveX Program | Default Settings MOS Version  Local DragDrop | Mod

[l MOSART NRCS Plugin  HOST PC IP EMPSHTMLHost  SYSTEM URL=http //VIZRTV1-7WLUOD1:55142/plugin Pnres=ENP Sémosid=Mosart s2mos  2.8.4 On

& Note: The URL comprises a combination of the Plugin's URL + a fixed port number
and Viz Mosart's Mosld value in the form:
http://machine-name:55142/plugin?nrcs=ENPS&mosid=xxxx .

If you need to derive current Mosld value, see the item To find your Mos ID.

iINEWS

There are two possible setup routes, depending on whether your iNEWS version supports HTML5
plugins. Please consult the documentation of your iNEWS system to determine whether this is the
case.

iNEWS Clients with HTML5 Support
iNEWS Clients without HTML5 Support

iINEWS Clients with HTML5 Support

1. In the iINEWS client, from the directory navigation tree, open the file SYSTEM.MOS-MAP and
verify that between TABLE-START DeviceTable and TABLE-END there is a line

mosart ...
If not, add the mosart reference,
For example: mosart MosartNRCSPlugin
2. For this step and the next, please refer to Avid's MediaCentral Newsroom Management Setup
and Configuration Guide, section Configuring Newsroom Management for HTML5 (chapter
HTML5 Plugins) .
If you have at least one HTMLS5 plugin already defined, you can skip this step.
From Avid's Configuring Newsroom Management for HTML5, follow the 1 to 6 with one
clarification:
- Step 3: (name of the new queue): Use the name HTML-PLUGINS, as recommended by
Avid.
3. Continue with steps 7 to 10, observing these clarifications:
- Step 7: In case you skipped the previous step, the queue refers to SYSTEM.HTML-
PLUGINS
Step 9: (slug): Enter something like Viz Mosart NRCS Plugin. (This is the string that will
be shown in the Plugins sub-menu of the Tools menu.)
- Step 10: (parameters): In the Story panel,
i. Enter 'URL =".
ii. At that exact spot, paste the URL copied from the Configuration tool
(if the Configuration Tool is not already running, select Windows Start > Viz
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Mosart NRCS Plugin Configuration Tool)

Plugin

iii. Finally, append

mosltemBrowserProglD = Mosart.ActiveX
mosltemEditorProglD = Mosart.ActiveX

For example:
URL = http://BGO-EDR2:55142/plugin?nrcs=iNews

mosltemBrowserProglD = Mosart.ActiveX
mosltemEditorProglD = Mosart.ActiveX

A Note:
- The parameter mosltemPlayerProglD mentioned in the Avid document is not
mandatory in this context.
- The URL element mosid is not required for iNEWS.

A Note: If Mosart ActiveX opens when trying to modify/edit a Mosart items (when double
clicking on the item), you must first uninstall Mosart ActiveX.

iNEWS Clients without HTML5 Support
Installing the iNEWS Client Addon

For older versions of iNews without HTML5 support, you need to install a small wrapper utility,
the Mosart NRCS Plugin - iNEWS Client Addon on each iNEWS client machine.

1. From the Vizrt FTP /products/VizMosart/Latest Version/WebApplications/
download and run the utility file MosartNRCSPlugin-iNEWSClientAddon-1.1.0.94.exe

2. Under Install options > Mosart NCS Plugin URL , paste the URL of the Plugin ( http://machine-
name:55142/plugin?nrcs=iNews ).

& Note: This is the URL you save with the Configuration Tool Copy button.
If the Configuration Tool is not already running, first select Windows Start > Vizrt
Mosart Web Applications Configuration Tool.

Plugin
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Version 1.1.0.0

Installer for NC Plugin, an adapter for running Mosart NCS Plugin as
an ActiveX plugin in newsroom systems.

Install Location

CAProgram File \Mosart NCS Plugin

Install options:

Mosart NCS Plugin URL
http:/fBGO-EDR2:55142/plugin?nrcs=iNews

NSTALL

3. Click Install.

4. Open/Restart your iNEWS Client.
The Viz Mosart NRCS Plugin is under:
Tools > Plugin > Mosart NRCS Plugin.

& Note: If Mosart ActiveX opens when modifying a Mosart items (by double clicking on it),
uninstall, then reinstall the file MosartNRCSPlugin-iNEWSClientAddon-1.1.0.0.exe.

Octopus

1. In the Configuration Tool, (if not already running, select Windows Start > Vizrt Mosart Web
Applications Configuration Tool) on the Mosart server, collect the NRCS Plugin's URL with the

Copy button:

2. Log-in to Octopus with Admin privileges.
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3. From the sidebar, navigate to MOS Devices > Devices, select mosart and click Edit.

MOS Devices ~ Devices & |

I x| ag L )

Ed\tdl Delete Contentsync CGtemplate sync Export/Import MOS objects Resend active rundov

Story Folders

E‘ Rundow

OCTOPUS NEWS 7/8/2021 19:00
OCTOPUS NEWS 7/7/2021 20:00
‘OCTOPUS NEWS 7/7/2021 19:00
OCTOPUS NEWS 7/6/2021 20:0 )

—
@ Archive
pilot

User PILOT
Admin servers
Menu
Dictionary
Field Dictionary
Banned Words
Wires

Mew Media

Story

Tags

Assignment Folc ers

Show
Forms

4. Select the Plugins tab:

Connection config

ncsiD: OCTOPUS
Device media address: 10.211.8.55 10840
Device rundown address: 10.211.8 55 10841
Octopus media port: 10840

Octopus rundown port: 10841

ncslD: Octopus8

Device media address: 10.211.112.37 10540
Device rundown address: 10.211.112.37 10541
Octopus media port: 10540

Octopus rundown port: 10541

Octopus IP address: 10.211.112.32

ncslD: OCTOPUSS

Device media address: 10.211.112.37 10540
Device rundown address: 10.211.112.37 10541
Octopus media port: 10540

Octopus rundown port: 10541

Octopus IP address: 10.211.112.32

I8 Device
Basic Stories Rundowns
G Support MOS objects Placenolders

MOS objects from plugin are private
[ Send user domain to plugin

[ Accept itemEdStartiDur from plugin
[ Send itemEdStartDur to plugin

[ Accept itemChannel from plugin

[ Send itemChannel to plugin

Prompting Status Cha
MOS object groups Activations

5. Fill-in as below, and providing:

a. A unique name
b. Version

¢. The URL to the Viz Mosart NRCS Plugin (pasted from step (1).
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o1

evice

Basic
G Suppord

Short name: |Mosar‘[ MCS Plugin

Long name: |Mosart MCS Plugin

| | Lowre

izt C

Version: ‘Z.B_Web

Platform: Chrome (CEF)

Plaoement:‘Modeless v|

Shortcut number: I:I

[] stretch when inline

[] Allow creation in media
Run in separate thread
Run in separate process
Run in native window

] Reuse running plugin

[T Use =ncsApplnfo=

] =ncsApplinfo= sends =item=

] show use

[]show close

Close when object arrives

] Primary editor

(] Allow in read-only scriot,

Implementation: | hitp:# fvizrit-4v public:55142/plugin nres=0ctopusdmosid=Mozart 2-mos |

In Case of ACIVEA enter

an parentheses) or Frog

Separate process directory: |

6. Setup is complete.

When editing a selected rundown, the user right-clicks for New > Create using <given name
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Il—l_

ol MNew *
at Format >
e Generate First'Last words
It Undo Ctrl+Z
ir Redo CtrlY
hi

Cut Ctrl+X
2 Copy Ctrl+C
is

Paste Ctrl+V
)

Paste text only
5 Paste objects only
1 Select All Ctrl+A
Tl
ol Editor >

es not have any life-threatening inju

00:00:00:00

CG

MOS Object

Create using MosAX

Create using NCS (master)

Create using Mewsroom ActiveX
Create using Pilot Edge (bgo-hendrix)
Create using Pilot Edge (rist)

Create using PilotEdge 1.5

Create using PilotEdge 2.1

Create using Pilot Edge MNeo Design
Create using Pilot Edge new mosid

Create using Pilot Edge trunk

Mote
Duration Tag
Presenter

Timestamp

Ctrl+G

Ctrl+M
Chrl+2
Ctrl+3
Ctrl+1
Ctrl+4
Ctrl+5
Ctrl+6
Ctrl+7
Ctrl+8

Ctrl+9

Ctrl+Q
Ctrl+T
Ctrl+P

Ctrl+Semicolon

For more details, see the Viz Mosart Administrator Guide , section Manus Administrator > Settings

Editor MOS > NRCS Configuration.
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5.4 Hosting NRCS Plugin Within Pilot Edge

If you are using the Pilot Edge version 3.0 or later, you are now able to Host the NRCS plugin
within the Pilot Edge plugin.

5.4.1 How to Set up

- Open your Pilot Data Server.
Click on the Settings option.

\v I Z rt Service Template feed Data element feed | Settings Examples

¥x Pilot Data Server

Right click on the Pilot Settings text in the top right corner of the page, then click the Add
New Optional Parameter option

Pilc
Add New Optional Parameter

Delete Selected Optional Parameter

ription
eout waiting for Viz Preview Engine to signal the host application that it is up and running

d client-side to determine if subfields can be added to custom layouts. Should be set to true when using Preview Server 4.4.1 or above, and set to false

icates whether consent wi for usage data cc n. By ticking this checkbox, you allow all Vizrt applications connected to this server to collect
ibed in htp://telemet fpolicy ntml.

H default channel for data elements to the generated M L
s the default behav wing or hiding the graphic event timing options in Viz Pilot News when saving a data element. When enabled it will show the
ing editor, and when it will hide the timing editor. This setting can ridden by enbabling the ShowGraphicEventTiming setting for the

plate Info component Template Wizard on a template by template b

ing to disable the clearing of all layers as th mands sent when sending to preview

ables the save button in Viz Pilot News, sa the user can only u

ables dragdrop in Viz Pilot News. Useful when using a newsraom system that does not facilitate dragdrop interaction with plugins
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Add a parameter called moseditor_mosart_url which then appears in the list.

moseditor_mosart_ur

Name Description
If true, legacyTemplate ¢
MOS Item is sent.
https://bgo-wonderland.vizrt.iinte URL of the Pilot MOS H

mos_plugin_url rnal/pds/app/pilotedge/PilotEdg  that use redirection (HT
e.html latter that needs to be

mos_legacy_template

https://bgomsevizarc:9005/mos-
plugin

| moseditor_mosart_url Custom parameter.

moseditor_arc_url Custom parameter.

mse_script_runner Parameter can be used

https://v1poc.vizrtapps.com/task
ui/?form-columns=4&theme=viz
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In the value field, paste in the URL to your NRCS Plugin, for example: https://
localhost:55143/plugin/?nrcs=iNews.

Name Description
! If true, legacyTemplate
MOS Item is sent.
https://bgo-wonderland.vizrt.inte URL of the Pilot MOS H

mos_plugin_url rnal/pds/app/pilotedge/PilotEdg  that use redirection (H
e.html latter that needs to be

mos_legacy template

https://bgomsevizarc:9005/mos-
plugin

‘ moseditor_mosart_url http;://localhost:55143/p|ug|n/?n Custom parameter.
rcs=iNews

mse_script_runner Parameter can be used

moseditor_arc_url Custom parameter.

Click the Save button, on the top left.

& Note: If you are using the Pilot Edge on HTTPS, the Mosart NRCS plugin has to be on HTTPS
as well.

5.4.2 How to Use

Open the Pilot Edge plugin in your newsroom system, there is now a new tab on the top
named Mosart. When you click on it, the Mosart NRCS plugin opens.

¥ Viz Pilot Edge m G s M Images vVideos @ Mosart

&) Mosart NRCS Plugin

Gallery Template set

Testlab ~  DEMO
« -

Transition:
Reset efaul

B cAmera
PACKAGE
B voiceover

0s
MiX | WIPE  EFFECT
[l GRAPHICS
0 4 frames

-
VIDEO EFFECT clipfullmixeffect

B rHono PACKAGE

BB FLoaT
| EE
W VIDEOWALL
« SOUND
A ACCESSORIES

C COMMAND
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If you want to Drag in a Mosart item into your rundown, you cannot drag directly from the
plugin itself. Instead you have to select the item you want to drag, then drag the cross icon
at the very top right of the plugin.

@ Mosart

Editing an item works exactly the same as if you were using the Mosart NRCS plugin
normally. Just now if you try to edit a Mosart item that was dragged in while hosted in Pilot
Edge, it automatically opens the the NRCS plugin within Pilot Edge.

A Note: As of right now, editing items ONLY works properly in INEWS.
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6 Mosart Timing Display

The Mosart Timing Display web app provides browser-based timing information for the studio
control room and studio floor.

@ Timing Display  Defauit Layout B Saveas.. O View 1 Copylink

12:46:53 PM ControlRoomXXX 23:54:05

12:40:58 PM SHOW.ESPEN.NEWS 00:00:03

-54:02

Today's news

+04:28

CAMERA 1

+04:39

Covid is cured! CAM E RA 2

Synchronizes with the active Viz Mosart rundown, it can be customized to display user-
specific details.

Supports a variety of devices.

For example an iPad or networked phone.

Provides multiple, customized timing displays.

For example, one timing display can be running on the studio floor, connected to the in
house intercom system. A second timing display is in the control room counting down
packages, keeping the producer updated on the current show.

& Note: For news-breaking details on the Mosart Timing Display, please refer to the Mosart
Web Apps Release Notes for your version of Viz Mosart at the Vizrt Documentation Center.

This section describes:

Working with the Timing Display
Setup and Administration
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6.1 Working With The Timing Display

- Key Features
- Operating Modes
- View Mode
- Edit Mode
- Audio Countdown
- Distributing a Timing Display

6.1.1 Key Features

- Supports a variety of devices (for example an iPad or networked phone).

- A 24 x 24 editing grid enables rich flexibility for timer layouts.

- Each timer has a consistent and readable appearance. Available space is optimized with
proportionate fonts.

- Rapid drag and drop of timer elements, from an intuitive list.

- Rich text formatting: Color picker + Bold + Alignment + Show label.

6.1.2 Operating Modes

For daily operations, the Timing Display runs in View Mode. Use Edit Mode to create or adjust the
display.

View Mode

Browse-anywhere timing information in your web browser.

<

C A Notsecure | viztvi-cv79r6r55142/timingdisplay/D)_gallery3 R LENE N

7:N7.E0 N4 ControlRoomXXX 22:24:25

Layout: | DLgallen

e — ODS NSW Local 1730 MONDAY 00:30:00

-54:16

00:00 STUDIO SET UP 00:00

00:00

STUDIO SET UP

00:07/

OPENER-SHORT OPENER B R EAK E N D B I_AC K
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In View mode you can:

Mouse-over a timing detail for an explanation.

00:02:57,

Duration to Mest Break

Display as full screen.

Full=creen

To display a Timing Display in View mode

- View Mode is the result of Distributing a Timing Display.
- You can also browse a Timing Display in View Mode, by clicking the View button in the menu

bar.
B Timing Display = Defeuit Layou

Q e 4:42:55 PM

Current

The View Mode opens in a new tab.

Edit Mode

To create and modify a Timing Display
You can reconfigure or create a new Timing Display with details relevant to your operation.

1. If no Timing Display editor is running in your web browser
a. From the desktop shortcut or Programs menu, start the Viz Mosart Web Applications
Configuration Tool.
b. In the Timing Display panel, click Open.
A Timing Display editing web page opens.
2. Configure the display. For example:
a. From the Timers panel to the left, drag any highlighted timing detail into the display
area.
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b. From the display area, click on any timing detail and edit/delete.

00:02:57

|} L n
00:00-
L]
L L} L
Current Story Time
20000 B

A Note: The action Delete simply returns the selected timing detail back to the
Timers selection panel on the left.

B Soveas. i 0 Copylink

1056:04AM ControlRoomXXX 13:03:56

@ Timing Display  DefauitLayou

SHOW.LAURA.ENG_SW_SHOW 00:00:00

12:00:00 AM

- ATATIAYA 1 A ATATIATA
3. From the menu bar, click Save as and enter a unique, meaningful name for the display.

Audio Countdown

Prerequisites

Timing Display plays its audio files located in the "C:\ProgramData\Mosart Medialab\Mosart Web
Apps\TimingDisplayMedia" folder of the host machine for Timing Display.

Each audio file that you wish to use must be placed here.
The range of supported audio file formats is dependent on the web browser you use for the
Timing Display, This external article lists audio formats supported per browser

To activate audio countdown in a Timing Display
1. Open Timing Display in Edit Mode.
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2. In the menu bar at the top of the page, click Audio Countdown.

B Save as... O view 0 Copy link 4)) Audio Countdown

MOSART_BACKUP_CONTINUITE_IFS 08:36:56
B 00:00:00

-30:56

Rundown Over/Under

- () () (M)
3. From the dialog window that appears, click Add Countdown.
4. In the drop-down menu Filename , select the audio file you want to play.

Audio Countdown Scheduler

+ Add Countdown

Starts at I ENE

0 After 10_sec.wav

10_sec.wav
10_sec_cam_1.wav

10_sec_cam_2.wav

10_sec_cam_3.wav

10_sec_cam_4.wav

1N ser ram & wav

The selections are audio files added to "C:\ProgramData\Mosart Medialab\Mosart Web
Apps\TimingDisplayMedia" (on the machine where the Mosart Web Apps are installed).
You can also test the selected audio file by clicking on the Play icon to the right of the
dropdown menu.

5. In the drop-down menu Event, select the event you want the audio file to countdown
towards.
Choose from:
- End of Current Story: Counts down to the end of the current story.
- Start of Next Break: Counts down to the next planned break.
- End of Rundown: Counts down to the planned end of the rundown.
- End of Current Package: Counts down to the end of a current Package template.
- End of Current Break : Counts down to the end of a current Break template.
- End of Current Voice Over : Counts down to the end of a current Voice Over template.
- End of Current Float/Adlib : Counts down to the end of a current Float/Adlib template.

Copyright © 2024 Vizrt Page 45



Mosart Web Applications Guide - 1.7

- End of Current Item : Counts down to the end of each respective Story item.

Audio Countdown Scheduler

+ Add Countdown

Starts at Filename
0 - 5ec ‘ Before ‘ After 10_sec.wav

End of Current Story
Start of Next Break

End of Rundown

End of Current Package

End of Current Break

Fnd nf Current Vnire Nver

6. Set the number of seconds Before or After the event you want the Audio file to Start at.
Audio Countdown Scheduler

+ Add Countdown

Starts at Event Filename

sec ‘ Before ‘ After End of Current Story 10_sec.wav

7. Repeat steps 3 to 6 for all required audio files.
8. Click OK

To verify, start a rundown and listen that the correct audio files plays at the specified time.
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A Note: If you refresh the Timing Display, you must again perform some activity on the web
page before any audio can be played.
Simplest is just clicking on the page or pressing any keyboard key while the web page has
focus. This is standard web browser behavior.

6.1.3 Distributing a Timing Display

Once you have created or modified a Timing Display, you can share it with other users on the same
network.

To distribute a Timing Display

1. Create/modify the Timing Display as described in Creating and modifying a Timing
Display above.

2. From the drop-down menu, select the required display.
Default Layout
Default Layout

3.

4. Share the URL with your users.

& Note: The original Viz Mosart Timing Display, with explanation of the elements, is
described in the Timing Display section of the Viz Mosart User Guide .

© Tip:

Appearance of timing information in the Viz Mosart Ul
? 08:44:58 ©31:51
°+12:44

Program

] VIDEO EFFECT 2BOX ©12:49

1.
2.
3.
4.

Counts the downtime to the next break.

Counts how much the rundown is over/under.

Counts down the remaining time for the current On Air template.
Shows the duration of the current On Air template.
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6.2 Setup And Administration

- Setting up the Timing Display
- Prerequisites
Download
Installation
Configuration
- Additional Server Settings
- Support for Main/Backup Connection
- Troubleshooting
- Web Apps Service Reports as Offline
Bypass the Mosart Web Applications Configuration Tool to Access Web Apps
Firewall Ports

6.2.1 Setting up the Timing Display

Prerequisites

- Viz Mosart 5.0.3 or later.

& Note: Timing Display will work out of the box, as long as you install the Mosart Web
Applications on the same machine as the Viz Mosart Server .

Perform all three procedures, Download, Installation and Configuration.

Download

- Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

& Note: If upgrading, make sure an existing instance of the Mosart Web Applications
Configuration Tool is not open.

Installation
The Mosart Web Applications bundle shall be installed on the Viz Mosart server.
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1. Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

Q

Viz Mosart Web Applications is a growing collection of modern,
browser-based utilities, designed to enrich the Mosart workflow.

Version 1.4.0.0

The following applications are about to be installed:

* Viz Mosart NRCS Plugin
* iz Mosart Timing Display

INSTALL

The web applications that will be installed are listed.

& Note: The Installer places two applications on the local machine
a. Vizrt Mosart Web Applications
b. Vizrt Mosart Web Applications Configuration Tool

2. Click Install.
Any previously installed versions of the Mosart Web Applications are automatically
upgraded.

3. After successful installation, a Mosart Web Applications Configuration Tool automatically
displays.

&% Mosart Web Applications BF Settings

-~ ® CONFIGURATION REQUIRED ® ONLINE =3 ® ONLINE
@

NRCS Plugin B Timing Display = Rundown Viewer

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information for The Rundown viewer provides a read-only
effortlessly insert Viz Mosart template information the studio control room and studio floor. presentation of the Rundown.
into an NRCS.

® Documentation ¥ Configure ® Documentation (@ Documentation
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A Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by
default.

L ©
e

VizrtMosart

Web
Applications
Configuration

Tool

4. Port settings (optional)

Where security policies restrict ports firewall ports, these are the necessary port numbers for
Mosart Web Applications:

a. Web Apps REST API
HTTP: 55142.

HTTPS: 55143.

b. Remote Control Service (Used by the Timing Display and Rundown Viewer)
HTTP: 55167 .

HTTPS: 55168.

Configuration

& Mosart Web Applications

Az) ® ONLINE ® ONLINE

~1 NRCS Plugin a Timing Display

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information for
effortlessly insert Viz Mosart template information the studio control room and studio floor.
into an NRCS.

NRC

0 copy

(® Documentation ¥ Reconfigure @ open (@ Documentation @ open

A yellow warning icon and text CONFIGURATION REQUIRED alert if further user settings must be
entered.

In the Timing Display panel click Open.

A Timing Display with layout editor opens. Here you can create your required timer details,
or use the default appearance.
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Additional Server Settings

Web Server Hostname

At startup, the Configuration Tool attempts to autodetect the web server hostname and if
successful, pre-populates the field.

For some setups, the Configuration Tool's web server pre-populated hostname will differ from the
fully qualified domain name (FQDN). For example, the hostname gets automatically pre-populated
as web-apps, yet the FQDN is web-apps.example.com.

To Enable Network Communication with Mosart Web Apps
You can enable other machines on the network to reach Mosart Web Apps.

1. From the Configuration Tool menu bar, click the Settings (gear) icon. The Server
Configuration menu appears.

Web server hostname VIZRTVI-CV79RER

Use HTTPS

Certificate File
Private Key

Password

£ Configure @ Documentation
1

2. In Web server hosthame, enter the FQDN.
3. Click Save.

Enabling HTTPS

The Web Applications suite optionally supports HTTPS authentication for the applications running
under it, with a centralized interface to help with certificate configuration.

& Note: Depending on the application, some additional configuration may be needed in the
connected applications (for example Viz Mosart itself) to enable HTTPS communication.

Step 1 - Activate HTTPS in Mosart Web Applications

1. Launch the Viz Mosart Web Applications Configuration Tool (a desktop shortcut is usually
available by default).

2. In the top right corner, select the Settings (gear) icon. The Server Configuration menu
appears.

3. Select Use HTTPS.
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& Note: This selection turns on HTTPS for the NRCS Plugin, Mosart Timing Display and
Rundown Viewer.

4. Provide certificate, key and authentication details (consult with your IT department to obtain
this).

Server Configuration

Web server hostname win-8urqgf15ss8p

¥ Use HTTPS

Certificate File C:\Sources\sshl-win-Burqf15ss8p.c @ ‘ D

Private Key C:\Sources\ssl-win-Burqf15ss8p.} ‘ 0D

Password L0 ‘

{ZJ Documentation

5. Click Save.

Step 2 - Turn HTTPS on in Mosart Remote Dispatcher Service

1. Copy the file C:\Program Files (x86)\Mosart Medialab\Mosart

Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml" to "C:\ProgramData\Mosart
Medialab\ConfigurationFiles.

2. Fill in the following fields, using the same three values from the HTTPS Configuration menu
shown above:

SignalRUseHttps: true
SignalRCertificatePath: <Certificate File entered above >
SignalRCertificateKeyPath: <Private Key entered above >

SignalRCertificatePassword: <Password entered above >
name=
name
name

name=

3. Restart the Remote Control Service.

6.2.2 Support for Main/Backup Connection

Currently there is no autonomous support at switching.

A simple workaround is creating two open Timing Display instances and manually switching
between them.

6.2.3 Troubleshooting
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Web Apps Service Reports as Offline

At any time you can start the Mosart Web Applications Configuration Tool and check operating
status.

A common error is when a Windows service has failed.

- Try restarting the service with the Restart button.
@ Viz Mosart Web Applications

Windows Service is offline. Try to restart it.

(»}) OFFLINE OFFLINE
-

NRCS Plugin O Timing Display

This NRCS plugin enables a Viz Mosart operator to The Timing Display provides timing information for

- You can also rewrite any previously entered values with the Reconfigure button.

Bypass the Mosart Web Applications Configuration Tool to Access Web Apps

In failure situations, you can use your web browser to communicate with the Mosart Web Apps
(instead of the Configuration Tool).

NRCS Plugin

1. From the Configuration Tool, copy the NRCS link (click Copy).

4 ® ONLINE
(&) NRCS Plugin

This NRCS plugin enables an NRCS operator to

effortlessly insert Viz Mosart template information
into an NRCS.

NRCS link:

The URL has the form similar to: http://<your-hostname>:55142/plugin/?
nrcs=ENPS&mosid=mosart
2. Open you web browser and paste the URL in to see the NRCS Plugin.

Rundown Viewer

Edit the URL to: http://<your-hostname>:55142/rundown

Timing Display
Edit the URL to: http.//<your-hostname>:55142/timingdisplay/editor
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Firewall Ports

Refer to the optional Configuration step Port settings (optional).
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7 Mosart Rundown Viewer

The Mosart Rundown Viewer provides a convenient web browser view of details from the current
Viz Mosart rundown.

Displays the active Viz Mosart rundown.
Summary of story timings.
Supports a variety of devices. For example an iPad or networked phone.

& Note: For news-breaking details on the Mosart Rundown Viewer, please refer to the Mosart
Web Apps Release Notes for your version of Viz Mosart, at the Vizrt Documentation Center.

= O

-4 Mosart Rundown Viewer x +

C A Notsecure | vizrivi-cv79r6r55142/.. @, |28 ¥ E‘m & » 0O G .

Story scaling:

Clip1

Clipz

COpenerl

This section describes:

Working with the Rundown Viewer
Setup and Administration
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7.1 Working With The Rundown Viewer

- Opening the Rundown Viewer
- Story Scaler
Go to On Air Story

7.1.1 Key Features

The Mosart Rundown Viewer provides a convenient, browser based display of a Viz Mosart
rundown.

& Note: To browse a rundown in Rundown Viewer, a standard Viz Mosart setup must first be
running with a loaded rundown. See section Setup and Administration.

Opening the Rundown Viewer

You access the Mosart Rundown Viewer from the Mosart Web Applications Configuration Tool.

To open the Mosart Rundown Viewer

1. Start the Mosart Web Applications Configuration Tool.
This is either a Desktop shortcut

Vizrvosart

1|.|'|.|I.E h
Applicatio
EONTguration:

or accessed from the Windows Start menu by typing Mosart Web Applications.
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2. From the Rundown Viewer panel, click O

c @ ONLINE
[— | -
= | Rundown Viewer

The Rundown viewer provides a read-only
presentation of the Rundown.

(3 Documentation & Open

3. The Mosart Rundown Viewer displays in your default web browser.
3 Mosart Rundown Viewer x @ Mosart Timing Display x| + v = 'Y
@ A Notsecure | vizrtvi-cu79r6r55142/rundown/ t Bk 00

& Mosart Rundown Viewer

redowr Story Countsiown  em Countown

-57:31 +00:50  +00:45

Never ending story

New cinema in town

00:49
Election

Plane successfully landed

A before B

100 years old

@ For a explanation of the elements in a Viz Mosart rundown, please refer to the Viz Mosart
User Guide , under User Interface, the section Rundown Window.

Story Scaler

You can expand the viewing area for items in a story row. This is useful to see full text details on
an item.
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Adjust the Story scaling slider to desired column width.

Graphics
cam . Graphics

Clip1 . Cam

Clip2 . clip

Opener1 clip2

Openert

Go to On Air Story

A navigation button
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enables immediate scrolling to the current on-air story.

Story scaling ©)

SHOW.ESPEN.TESTING | DEMO Next break: 09:04:07 AM

Rundown over/under Story Countdown Item Countdown

-56:36 +18:15 +18:10
00:30

L
e

00:11 Camera templates

00:04 AdLib templates
1 ':

00:10 Two AdLib templates

{10 [7 N2

B )
Altering full screen graphics while cucued in

00:11 story
1 (=T
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7.2 Setup And Administration

Setting up the Rundown Viewer

Prerequisites
Download
Installation
Configuration

- Additional Server Settings

- Troubleshooting

- Web Apps Service Reports as Offline

Bypass the Mosart Web Applications Configuration Tool to Access Web Apps

Firewall Ports

7.2.1 Setting up the Rundown Viewer

Prerequisites
- Viz Mosart 5.1.0 or later

Perform all three procedures, Download, Installation and Configuration.

Download

- Collect the latest software bundle from Vizrt's customer FTP at https://download.vizrt.com/
by navigating to /products/VizMosart/Latest Version/WebApplications/.

& Note: If upgrading, make sure an existing instance of the Mosart Web Applications
Configuration Tool is not open.

Installation

The Mosart Web Applications bundle shall be installed on the Viz Mosart server.
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1. Run the downloaded file MosartWebApplications.Bundle-n.n.n.n.exe.

Q

Viz Mosart Web Applications is a growing collection of modern,
browser-based utilities, designed to enrich the Mosart workflow.

Version 1.4.0.0

The following applications are about to be installed:

* Viz Mosart NRCS Plugin
* iz Mosart Timing Display

INSTALL

The web applications that will be installed are listed.

& Note: The Installer places two applications on the local machine
a. Vizrt Mosart Web Applications
b. Vizrt Mosart Web Applications Configuration Tool

2. Click Install.
Any previously installed versions of the Mosart Web Applications are automatically
upgraded.

3. After successful installation, a Mosart Web Applications Configuration Tool automatically
displays.

&% Mosart Web Applications BF Settings

-~ ® CONFIGURATION REQUIRED ® ONLINE =3 ® ONLINE
@

NRCS Plugin B Timing Display = Rundown Viewer

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information for The Rundown viewer provides a read-only
effortlessly insert Viz Mosart template information the studio control room and studio floor. presentation of the Rundown.
into an NRCS.

® Documentation ¥ Configure ® Documentation (@ Documentation
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A Note: A desktop shortcut to Mosart Web Applications Configuration Tool is added by
default.

L ©
e

VizrtMosart

Web
Applications
Configuration

Tool

4. Port settings (optional)
Where security policies restrict ports firewall ports, these are the necessary port numbers for
Mosart Web Applications:
a. Web Apps REST API

HTTP: 55142 .

HTTPS: 55143.

b. Remote Control Service (Used by the Timing Display and Rundown Viewer)
HTTP: 55167 .

HTTPS: 55168.

Configuration

1. Ensure that your Viz Mosart system is operating under normal working conditions.
As a minimum,
a. ManusAdmin must be running.
b. The Viz Mosart Ul is running, displaying a rundown.
2. From the Viz Mosart Web Applications Configuration Tool, in the Rundown Viewer panel,
click Open.

2 Mosart Web Applications

-~ ® ONLINE ® ONLINE =3 ® ONLINE
@ =

NRCS Plugin a Timing Display =1 Rundown Viewer

This NRCS plugin enables an NRCS operator to The Timing Display provides timing information for The Rundown viewer provides a read-only
effortlessly insert Viz Mosart template information the studio control room and studio floor. presentation of the Rundown.
into an NRCS.

NRCS link:
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The Rundown Viewer automatically displays in your default web browser.
v = m] *

B Mosart Rundown Viewer X +

secure | vizrtvi-cv79rbr:55142/rundown/ Q [E=. ~ 4 Eh & * EI o

Stary scaling:

Intro

Header 1

Header 2

Andrew Bush

Weather check

Additional Server Settings

Web Server Hostname

At startup, the Configuration Tool attempts to autodetect the web server hostname and if
successful, pre-populates the field.

For some setups, the Configuration Tool's web server pre-populated hostname will differ from the
fully qualified domain name (FQDN). For example, the hostname gets automatically pre-populated
as web-apps, yet the FQDN is web-apps.example.com.

To Enable Network Communication with Mosart Web Apps
You can enable other machines on the network to reach Mosart Web Apps.

1. From the Configuration Tool menu bar, click the Settings (gear) icon. The Server
Configuration menu appears.

Web server hostname VIZRTVI-CV79RER

Use HTTPS

Certificate File
Private Key

Password

@ Documentation

2. In Web server hosthame, enter the FQDN.
3. Click Save.
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Enabling HTTPS

The Web Applications suite optionally supports HTTPS authentication for the applications running
under it, with a centralized interface to help with certificate configuration.

& Note: Depending on the application, some additional configuration may be needed in the
connected applications (for example Viz Mosart itself) to enable HTTPS communication.

Step 1 - Activate HTTPS in Mosart Web Applications

1. Launch the Viz Mosart Web Applications Configuration Tool (a desktop shortcut is usually
available by default).

2. In the top right corner, select the Settings (gear) icon. The Server Configuration menu
appears.

3. Select Use HTTPS.

& Note: This selection turns on HTTPS for the NRCS Plugin, Mosart Timing Display and
Rundown Viewer.

4. Provide certificate, key and authentication details (consult with your IT department to obtain
this).

-
Server Configuration X

]

1

()

1

]

]

» ONLINE
B Rundoy
]
]
]
!
F
]
]
]
I
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]

Web server hostname win-8urgf15ss8p

¥ Use HTTPS

Certificate File C:\Sources\sshl-win-Burqf15ss8p.c ‘ (]
Private Key C:\Sources\sshl-win-8urqf15ss8p.} ‘

Password

-C'_?_] Documentation

5. Click Save.

Step 2 - Turn HTTPS on in Mosart Remote Dispatcher Service

1. Copy the file C:\Program Files (x86)\Mosart Medialab\Mosart
Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml" to "C:\ProgramData\Mosart
Medialab\ConfigurationfFiles.

2. Fill in the following fields, using the same three values from the HTTPS Configuration menu
shown above:

SignalRUseHttps: true
SignalRCertificatePath: <Certificate File entered above>

SignalRCertificateKeyPath: <Private Key entered above >
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SignalRCertificatePassword: <Password entered above >

name=

name

Nname=

name=" >

3. Restart the Remote Control Service.

7.2.2 Troubleshooting

Web Apps Service Reports as Offline

At any time you can start the Mosart Web Applications Configuration Tool and check operating
status.

A common error is when a Windows service has failed.

- Try restarting the service with the Restart button.
@ Viz Mosart Web Applications

Windows Service is offline. Try to restart it.

A’ OFFLINE OFFLINE
@

NRCS Plugin O Timing Display

This NRCS plugin enables a Viz Mosart operator to The Timing Display provides timing information for

You can also rewrite any previously entered values with the Reconfigure button.

Bypass the Mosart Web Applications Configuration Tool to Access Web Apps

In failure situations, you can use your web browser to communicate with the Mosart Web Apps
(instead of the Configuration Tool).

NRCS Plugin

1. From the Configuration Tool, copy the NRCS link (click Copy).

4 ® ONLINE
(&) NRCS Plugin

This NRCS plugin enables an NRCS operator to

effortlessly insert Viz Mosart template information
into an NRCS.

NRCS link

gin?nrcs=
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The URL has the form similar to: http://<your-hostname>:55142/plugin/?
nrcs=ENPS&mosid=mosart
2. Open you web browser and paste the URL in to see the NRCS Plugin.

Rundown Viewer

Edit the URL to: http://<your-hostname>:55142/rundown

Timing Display
Edit the URL to: http.//<your-hostname>:55142/timingdisplay/editor

Firewall Ports

Refer to the optional Configuration step Port settings (optional).
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8 Mosart Dashboard

8.1 Mosart Dashboard

This Mosart Dashboard provides essential control room information, eliminating the need of
displaying any Mosart Server applications.

& Note: This 1.0 version has minimal functionality and is provided as unsupported beta
software. Future versions, with additional functionality, will be supported.

C ) Mosart Dashboard

DEVICE TYPE STATUS
Newsroom system iNews bgo-mos-inews 0 Active

Video Server Main A Standby Activate

Full Screen Graphics 1-VIZRT ° Active

Standby

Overlay Graphics VIZRT MSE [DSK.new] Overlay Graphics Interface is not

running

Robotic Camera Control 1 - FX-MOTION o Active Standby

Studio 3 #*

Working with the Dashboard
Setup and Administration
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8.2 Working With The Dashboard

() Mosart Dashboard

DEVICE TYPE STATUS
Newsroom system iNews bgo-mos-inews 0 Active
Video Server Main A\ standby Activate

Full Screen Graphics 1-VIZRT Q Active Standby

Overlay Graphics VIZRT MSE [DSK,new] Overlay Graphics Interface is not
running

Robotic Camera Control 1- FX-MOTION o Active

Studio 3 °

8.2.1 Key Features

Device Status

Connection Status

Toggle Standby Mode

Server Status

Monitor a Different Mosart Server

Device Status

The Dashboard reflects current status of the devices configured on the Mosart server that are
running on the same server as the Dashboard Service:

(1] Video Server A\ standby

e Full Screen Graphics 1-VIZRT Q Active

Connection Status

The Dashboard reflects the connection status of the NCS connection:

DEVICE TYPE STATUS

Newsroom system iNews bgo-mos-inews Q Active
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Toggle Standby Mode

You can set a device into or out of Standby with the Standby and Activate buttons:

Standby Activate

Server Status

If a Mosart Server application ceases to function, you are warned in the Status section of the
Dashboard:

Overlay Graphics VIZRT MSE [DSK,new] Overlay Graphics Interface is not

running

o Robotic Camera Control 1 - FX-MOTION 0 Active Standby

Monitor a Different Mosart Server

You can change the Mosart Server you are monitoring. See section Monitor a Different Mosart
Server in Setup and Administration.
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8.3 Setup And Administration

The Dashboard has two parts:

- the Dashboard backend
- the Dashboard frontend.

Both are Windows Services and may reside on the same or on different computers.

The frontend serves the Dashboard Ul, accessible from multiple computers/browsers. They are
separate Dashboard Ul instances and can connect to the same or different backends.

The backend must be installed on the computer where the Viz Mosart Server you want to monitor
is installed.

The Dashboard Ul refers to the web page that appears when requested from the Dashboard
frontend service.

Prerequisites
Installation
Configuration

8.3.1 Prerequisites

- ASP.NET Core Hosting Bundle on the machines that you install the services on
- Viz Mosart 4.1.0 or later

Uninstalling of any earlier Mosart Dashboard service versions

Latest version of Google Chrome

8.3.2 Installation

1. From the Vizrt customer FTP (https://download.vizrt.com/), download the directory //
products/VizMosart/Latest Version/VizMosart-n.n.n/WebApplications/MosartDashboard-
n.n.n

2. Install the Dashboard backend (MosartDashboardService-1.0.0.0.msi) service on the same
machine as the Mosart server installation you wish to monitor.

& You can only monitor one Viz Mosart server per Dashboard.
However, if there are several Mosart servers that you are interested in potentially
monitoring, (for example either a main or backup in a redundancy setup), install the
Dashboard backend service on each additional machine.
See Monitor a Different Mosart Server below.

3. If the Dashboard Ul will reside on a different machine to the the backend server specified in
step (2) above, open port 55143 (in Firewall preferences).
You can skip this step, if the Dashboard Ul is displayed on the same machine as the
Dashboard backend.

4. Install the Dashboard frontend (MosartDashboardUIService-1.0.0.0.msi) service on any
machine.
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8.3.3 Configuration

1. On the machine you want to display the Dashboard, access http://HOST:8000/ in you
browser.
HOST is the computer name/IP address of the computer where you installed the frontend
service, at Installation step (4) above.
2. At initial startup, the Ul will prompt you for:
a. The host of the backend service.
Enter the host name of the machine from Installation step (2) above.
b. A name for this server.
Enter a human-friendly name of your choice.

Enter server details
Host

bgo-edr2

Name

Studio 3

Monitor a Different Mosart Server

You can change the Mosart Server that is monitored (the Dashboard backend service, as specified
in step (2) above, needs to be running on the target computer).

To select the monitored server

1. Click the Edit icon in the lower right corner.

Studio 3 ,‘

2. Enter the new server details, as described in Configuration step (2) above.
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